
SAP2000 v 18.0.1 2015-11-12 Page 1 

SAP2000® Version 18.0.1 

Release Notes 
© Copyright Computers and Structures, Inc., 2015 

Notice Date: 2015-11-12 
 

 

This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

 

Version 18.0.1 was released shortly after v18.0.0 to address several issues with the initial release of v18. For this 

reason the Release Notes for v18.0.0 are also included in this file. 

Changes from v18.0.0 (Released 2015-10-30) 

Miscellaneous 

Enhancements Implemented 

* Incident Description 

 85445 The version number has been changed to v18.0.1 for a new minor update. 

User Interface and Display 
Incidents Resolved 

* Incident Description 

* 85432 An incident was resolved in which the 64-bit version of the program could take a minute or more to 

launch on certain machines. This is a result of Microsoft's JIT (just-in-time) compiler and not a bug 

in the software. Not all systems are equally affected, and newer versions of the Windows (8.1 and 

10) tend to be less affected, especially if Windows Updates are current. A new tool, 

CSiNativeImageGen is available to 'precompile' the software after installation, prior to use. In most 

cases this should resolve the slow startup time, as well as speed up the displaying of forms. 

CSiNativeImageGen is available in the installation folder and must be Run As Administrator. 

Information on the use of this optional tool is provided within CSiNativeImageGen itself using t he 

Help command, and by searching the CSI Knowledge Base at wiki.csiamerica.com for 'native image 

generation'.  

Modeling 
Incidents Resolved 

* Incident Description 

 85311 An incident was resolved in which trying to access the Pipes and Plates templates when using the 

64-bit version would generate a series of error messages. These templates are currently not 

supported in the 64-bit version and a message to reflect this has been added. Users who need these 

templates should use the 32-bit version. 

Loading 
Incidents Resolved 

* Incident Description 

 85364 An incident was resolved for Chinese auto wind loading in which the mode shape period T1 was not 

accounted for while calculating the wind loading. 
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* Incident Description 

* 85382 

85534 

An incident was resolved in which the assignment of area loads to frames was actually being 

assigned as area uniform loads instead of area loads to frames. The analysis results would reflect the 

area uniform loads, and usually no load was lost. 

 85607 An incident was resolved where the diaphragm widths in X and Y directions were flipped when 

calculating the torsion due to specified additional eccentricity for response spectrum cases . 

Frame Design 

Incidents Resolved 

* Incident Description 

 83457 An incident was resolved for the Chinese Concrete frame design code for column design where the 

additional eccentricity moments were being added only on the positive side. Also the seismic 

moment modifiers, if overwritten, will now be applied even if the column compression ratio is 

below 0.15. 

* 85333 

85386 

An incident was resolved in which the steel frame design results could be incorrect and/or the right -

click design details were not able to be viewed when using the 64-bit version on certain machines. 

When results were available they could appear reasonable even if they were not correct. All steel 

frame design codes could be affected. This only affected v18.0.0, 64-bit. The 32-bit version was not 

affected. 

* 85387 An incident was resolved in which the Eurocode 3-2005 steel frame design was incorrect for box 

sections. Models with box sections designed in v18.0.0 should be redesigned. No other version were 

affected. 

* 85520 An incident was resolved for AISC 360-10 steel frame design in which the compression capacity of 

box, pipe, rectangle, circle, general, and section designer sections was being taken equal to the 

tension capacity, ignoring the compression capacity due to flexural buckling. This error could 

overestimate the compression capacity of these type of sections. This only affected models designed 

in v18.0.0. 

 
Results Display and Output 
Incidents Resolved 

* Incident Description 

 85453 An incident was resolved in which the graphical display of results on a limited selection of the 

model was taking extra time to display. This was a performance issue only and did not affect 

results. 

 85587 An incident was resolved in which the date on the report cover page was not correct. 

Database Tables 

Incidents Resolved 

* Incident Description 

 85481 An incident was resolved where exporting a table from the interactive database to Excel while the 

decimal separator was a comma might result in some values losing the decimal separator in Excel. 

Data Files 

Incidents Resolved 

* Incident Description 

* 85367 An incident was resolved in which trying to import frame section properties from a *.pro library file 

would generate an abnormal termination when the *.pro file was located in a folder without write 

permissions, which is usually the case for the default installation location. 
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External Import/Export 

Incidents Resolved 

* Incident Description 

 85289 

85506 

An incident was resolved where importing any DXF file into SAP2000 did not import anything - 

point objects, frame objects, nor shell objects. This affected version 18.0.0 only. 

Miscellaneous 

Incidents Resolved 

* Incident Description 

 85353 An incident was resolved in which a Microsoft Access message "Can't find Language DLL 

msain.dll" would appear on some machines when starting the program. 
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SAP2000® Version 18.0.0 
Release Notes 

© Copyright Computers and Structures, Inc., 2015 

Notice Date: 2015-10-28 
 

 

This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v17.3.0 (Released 2015-07-06) 

User Interface 
Enhancements Implemented 

* Incident Description 

 46985 

81772 

An enhancement has been implemented to allow selection of null frame objects assigned the 

“None” section property via the Select > Select > Properties > Frame Sections command. 

* 62650 

64942 

A full 64-bit version of SAP2000 is now available. The 32-bit version can be installed on either a 

32-bit or 64-bit operating system, while the 64-bit version requires a 64-bit operating system. 

* 69107 

72353 

An enhancement was implemented to add an Apply button to the Select and Assign command forms 

and allow them to remain open (floating) for continual use. 

Graphics 
Enhancements Implemented 

* Incident Description 

* 41385 

69876 

The DirectX graphics performance has been enhanced, especially for larger models containing 

many points. 

* 81474 DirectX graphics has been updated from DirectX 9 to DirectX 11. This may affect the graphics 

cards that are supported, particularly on older machines. 

Modeling 
Enhancements Implemented 

* Incident Description 

* 14367 A new two-dimensional concrete model has been added to the nonlinear layered shell. This model is 

based on the Darwin-Pecknold model, with consideration of Vecchio-Collins behavior. This model 

represents the concrete compression, cracking, and shear behavior under both monotonic and cyclic 

loading. The direction of cracking can change during the loading history, and the shear strength is 

affected by the tension strain in the material. The given material stress-strain curve is simplified to 

account for initial stiffness, yielding, ultimate plateau, and strength loss due to crushing. Zero 

tensile strength is assumed. The layered shell allows this material to be used for membrane and/or 

flexural behavior and to be combined with steel reinforcement in arbitrary directions and locations. 

Transverse (out-of-plane) shear is assumed to be elastic. 

* 34675 

40792 

An enhancement has been implemented to provide a semi-rigid option for diaphragm constraints. 

* 80135 An enhancement has been implemented to add two new capabilities to the Modify Undeformed 

Geometry feature, namely, 1) It is now possible to specify a coordinate system and one or more 

directions (X, Y, Z) to limit the direction in which the target displacement modification is applied. 

2) It is now possible to limit the modification, using either the target displacement or scaled mode-

shape option, to a selection of joints. 
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* Incident Description 

 83286 An enhancement has been implemented to update the Russian material library to modify the 

concrete ultimate strain values. 

Loading 
Enhancements Implemented 

* Incident Description 

* 15578 

18825 

An enhancement was implemented adding the ability to consider accidental eccentricity in 

response-spectrum load cases. 

 72234 An enhancement has been made to exclude the mass at restrained joints from being considered 

when computing the total mass for automated equivalent static seismic loads. Stiff springs should be 

used instead of restraints if such mass is to be included. 

 80688 

80935 

An enhancement was made so that the joint pattern assignment option using the Z Coordinate at 

Zero Pressure and Weight Per Unit Volume option calculates the resulting pressure value using the 

current units, not the specified values converted to database units. 

 81973 An enhancement was made to the Eurocode 8-2004 response spectrum function to add more 

discretization points for periods larger than Td. 

* 82280 Automated response-spectrum functions have been implemented for the following codes: Costa 

Rica Seismic code 2010, Ecuador (NEC-SE-DS 2015), Korea KBC 2009, Mexico (CFE-93 and 

CFE-2008), and Peru (NTE E.030 2014). 

* 82662 An enhancement has been made to add automated static seismic lateral loads based on the Korean 

Building Code (KBC 2009) and the Dominican Republic code(R-001). 

Analysis 
Enhancements Implemented 

* Incident Description 

* 68919 

70348 

The handling of convergence tolerances for time-dependent behavior during staged-construction 

analysis has been improved to better enforce equilibrium after large load increments have been 

applied. Previously the convergence tolerance used to measure equilibrium during the time-

dependent phase of a stage was relative to the magnitude of the load applied in that stage and 

previous stages. Now the convergence tolerance for the time-dependent phase is relative only to the 

internal creep and shrinkage effects themselves, and does not depend on the magnitude of any 

externally applied loads. This will have little effect on most models, but may improve the 

equilibrium for certain models without needing to tighten the convergence tolerance for the entire 

load case. It is always recommended that the effect of convergence tolerance upon results be 

examined when developing any nonlinear model. 

* 75659 A new stability check has been added for nonlinear load static cases. For force-controlled load 

cases, including staged construction, the stiffness matrix will be formed, solved, and checked at the 

final converged state for negative eigenvalues. The number found will be reported in the analysis 

log file (.LOG), and a stability warning issued in the log file if the number is greater than zero. 

Displacement-controlled load cases are not checked as these typically are used to analyze unstable 

structures, whereas force-controlled load cases are intended to be stable. 

 
Frame Design 

Enhancements Implemented 

* Incident Description 

 45985 An enhancement was implemented for the BS 5950-2000 steel frame design right-click design 

details to present the elastic modulus as Z and the plastic modulus as S, instead of the inverse which 

is used for other codes. 

* 58956 An enhancement has been implemented to provide torsion design of steel frame sections according 

to Eurocode 3-2005. The SCI Publication 385 "Design of Steel Beams in Torsion in Accordance 

with Eurocodes and UK National Annexes,"  by Hughes, A. F., Iles, D. C., and Malik, A. S. is taken 

as the guide for this implementation. Frame sections considered include open doubly-symmetric I-
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* Incident Description 

shapes and closed rectangular hollow sections and pipe sections. The current implementation 

considers the variation of the torsional moment along the length to be constant and/or linear; other 

variations will be approximated as constant plus linear.  

 60998 

82325 

An enhancement was made to include roof live load in default design combinations for ACI-318-08, 

ACI 318-11, and ACI 318-14 codes. Also companion loads were added to default design 

combinations for CSA A23.3-04, CSA A23.3-14, CSA S16-09, and CSA S16-14 codes. 

* 65245 An enhancement has been implemented to add steel frame design based on the Russian SP 

16.13330.2011 (SNiP II-23-81:2011) code. 

 76864 The handling of effective-length K-factors has been changed for steel frame design for the "AISC 

360-10" and "AISC 360-05" codes when the Analysis Method is set to "Direct Analysis". 

Previously the bending factors K22 and K33 were always taken as 1.0, and the lateral-torsional 

buckling factor K_LTB was taken as an internally calculated value for K22, which was generally 

greater than 1.0 and usually over-conservative. Furthermore, these factors were always being used 

and could not be changed by the user. Now the default values for all three factors (K22, K33, and 

K_LTB) are taken as 1.0, but these can be changed by the user by assigning design overwrites to 

specific frame members. This change only affects the design using the Direct Analysis Method. 

* 81910 A change has been made to remove older design codes which have been superseded. Models with 

older code assignments will now use the latest corresponding design codes. The following older 

codes  have been removed: For steel frame design "AISC-ASD01", "AISC-LRFD99", "BS5950 90", 

"CAN/CSA-S16-01", "CISC 95", "EUROCODE 3-1993", "Indian IS:800-1998", "Italian UNI 

10011", "Norsok N-004", "UBC97-ASD" and "UBC97-LRFD"; and for concrete frame design 

"ACI 318-99", "ACI 318-02", "ACI 318-05/IBC2003", "AS 3600-01", "BS8110 89", "CSA-A23.3-

94", "EUROCODE 2-1992", "Hong Kong CP 2004", "Italian DM 14-2-92", "KCI 1999", "Mexican 

RCDF 2001", "NZS 3101-95" and "UBC97". 

 82657 An enhancement was added for ACI 318-14, ACI 318-11, and ACI 318-08 concrete frame design 

codes where the Design System Rho (Ρ) and Design System SDS factors can be specified in the 

concrete frame design preferences. Previously, System Rho and SDS were internally used as 1.0. 

Design results may change if default values for Rho and SDS are used. 

* 82660 An enhancement has been implemented to add concrete frame design for the Korean Building Code 

(KBC 2009). 

* 82661 An enhancement has been made to add steel frame design based on the Korean Building Code 

(KBC 2009). 

 

Results Display & Output 
Enhancements Implemented 

* Incident Description 

* 34730 

55210 

An enhancement has been made so that contour plots are now available for frame axial stresses. 

Contour values are plotted as colors on the line or the extruded shape of the frame objects based on 

the extrusion setting. Currently only the I-Shape, rectangle, circle, tube and pipe are extruded for 

this operation; other sections will show as lines. When plotted on the line the color represents the 

maximum axial stress in the cross section. The axial stresses are the S11 components due to axial 

force plus bi-axial bending moment, and are provided for all load cases except influence-based 

moving-load cases. Stresses are calculated for the base material, and do not account for modular 

ratio. Stresses are computed for the section property assigned to the frame object, and do not 

account for the possibility that the section has been changed during staged construction. 

 79371 An enhancement was implemented to report the center of mass for each individual joint, as well as 

for the summation of mass accelerated in each of the three translational directions. This data is 

included in the Assembled Joint Masses database table. 

* 84141 

84466 

An enhancement has been made so that contour plots are now available for frame deflections. 

Contour values are plotted as colors on the line or the extruded shape of the frame objects based on 

the extrusion setting.  
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Application Programming Interface 
Enhancements Implemented 

* Incident Description 

 71255 An enhancement has been implemented, updating the API functions 

SapObject.SapModel.DesignSteel.Eurocode_3_2005.GetOverwrite and SetOverwrite to include 

additional overwrite items that were previously not accessible using these functions. 

 81247 An enhancement has been made to the API functions GetPreference and SetPreference for the 

Chinese 2010 steel frame design to allow getting and setting the Seismic Design Grade preference. 

* 82060 The SAP2000 API has been updated for v18 such that both v17 and v18 can coexist on the same 

machine. API tools and plugins written using the v17 API will need to be recompiled after changing 

the reference to SAP2000v18.dll. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

 81503 The export to Revit Structure has been enhanced so that steel sections are now exported 

parametrically, i.e., their dimensions are written in the .EXR file in addition to the section name. 

When CSiXRevit 2016.1 imports an .EXRfile into Revit Structure from SAP2000 and encounters a 

steel section with a name it cannot match to a Revit family type in the user’s Revit Structure 

template or family libraries, CSiXRevit 2016.1 will then create a new Revit family type based on 

the SAP2000 parametric section dimensions. Previous versions of CSiXRevit do not feature this 

functionality. 

Documentation 
Enhancements Implemented 

* Incident Description 

 13044 An enhancement has been implemented to define the list of documents shown via the Help > 

Documentation command using an XML file in place of the Microsoft Access database. This XML 

file can be modified by the user to add their own documents to the documentation tree within the 

software. 

Installation and Licensing 
Enhancements Implemented 

* Incident Description 

 71757 The license manager for network licenses has been updated to Sentinel RMS 8.6. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 81073 The version number has been changed to v18.0.0 for a new major release. 
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User Interface and Display 
Incidents Resolved 

* Incident Description 

 81497 An incident was resolved in which the modal case selected for defining additional frequencies for 

steady state or power spectral density (PSD) load cases was not always saved when multiple modal 

cases were defined in the model. The results agreed with the modal case shown when going back to 

review the steady state or PSD load case. 

 82317 An incident was resolved where in some rare cases the Auto Load Combination for Design form 

would give an abnormal termination error. The auto combination parameters were corrupted in the 

file and have been trapped. 

 82543 An incident was resolved to remove the Assign > Frame > End Skews command as it is not 

applicable to SAP2000. 

 82640 An incident was resolved in which an abnormal termination could occur after deleting certain load 

patterns and then trying to display loads on the screen. This was a user interface error and did not 

affect results. 

 82655 An incident was resolved in which values pasted into the quadrilateral cutting plane table on the 

Section Cut Data form were not retained after clicking OK. Directly typing in values would work as 

expected. This was a user interface issue. Results would agree with the defined cutting plane 

coordinates. 

 83429 An incident was resolved in which an abnormal termination could occur when trying to delete a 

reference point on the Edit Reference Points form. This was a user interface issue only. 

 84055 An incident was resolved where negative values were not being allowed for diaphragm eccentricity 

overwrites in the auto-seismic load pattern definition dialog. 

Modeling 
Incidents Resolved 

* Incident Description 

 39529 

41509 

66071 

66274 

An incident was resolved where, in certain rare cases, it was not possible to draw a long vertical 

cable. Drawing the cable as several shorter vertical segments would work. Other minor issues 

related to drawing cables were also resolved where the drawn shape would not appear symmetrical 

or could exhibit small oscillations at one end. This could result in unequal segment lengths if the 

cable was subdivided, or in the appearance of unexpected deflections. However, analysis results 

were always correct and consistent with the length of the drawn cable as shown in the Cable 

Geometry form and the Cable Shape Data database table. Results are not affected, except that the 

displayed deformed shape of the cable may appear different in certain cases. The actual deformed 

shape of the cable, its tension, and its action on the rest of the structure are unchanged. 

 82584 An incident was resolved where incorrect values were displayed in the textboxes on the Tendon 

Response Form. This was a display issue on this form only and did not otherwise affect the results. 

Analysis 
Incidents Resolved 

* Incident Description 

 79967 An incident was resolved where the analysis would sometimes run very slowly when there was a 

large number of linear load cases applying restraint displacement loads, such as might occur in large 

models imported from ETABS. This was an efficiency issue only. No results were affected. 

* 80931 An incident was resolved where the results of a moving load case could be incorrect for vehicles 

where the option "Vehicle Remains Fully in Path" was selected. This error, although not common, 

could occur in versions 17.2.0 and 17.3.0. Moving load cases containing such vehicles should be re-

run with the new version to confirm the results. Multi-step linear static load cases for vehicle loads 

were not affected, only influence-based moving load cases. 

 81970 An incident was resolved in which an abnormal termination could occur when running the analysis 

for a load case containing a seismic load pattern based on user loads if other constraints were 

specified before all the rigid diaphragm constraints were specified in the model. 
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* Incident Description 

 82986 An incident was resolved where an eigen-type of modal analysis could fail to complete, and 

generate an error message in the .LOG file, when performing a stiffness shift in a model containing 

cable objects if the modal analysis was run at the same time as a moving load case that used the 

stiffness from the end of the same nonlinear static load case (or zero initial conditions). When this 

occurred, the results of the modal analysis were not available. Results for load cases that did 

complete were not affected. Running the modal analysis separately from the moving load case 

would allow the modal analysis to complete. Models without cable objects were not affected. Modal 

load cases that did not require an automatic stiffness shift were not affected. 

Frame Design 
Incidents Resolved 

* Incident Description 

 77303 An incident has been resolved in several steel frame design codes in which the design reported the 

maximum tension force in the braces in the database tables “Tables: Steel Design 8 – Brace Max 

Axial Load -*” with the wrong sign, especially when special seismic design was done and seismic 

load was present. The design computed a single maximum axial force irrespective of sign (tension 

and compression). Now the design computes the maximum axial forces envelopes for tension and 

compression separately. This was a reporting issue only. Actual member capacity checks were 

unaffected. Affected codes are AISC 360-05, AISC 360-10, CSA S16-09, CSA S16-14, Eurocode 

3-2005, Italian NTC 2008, and Indian IS 800:2007. 

 77852 

82626 

An incident was resolved in frame design codes where the unbraced length ratios were calculated 

disregarding support provided by shells and solids. This error affected versions 17.0.0 to 17.3.0. 

Since the shell/solid supports were ignored, the resulting unbraced length in some cases could have 

been calculated as longer, thus conservatively resulting in larger stress or PMM ratios. The 

unbraced lengths actually used were being reported. 

 80830 

80861 

An incident has been resolved in steel frame design per the AISC 360-10 code in which the design 

erroneously reported an error message that a section was not "Seismically Compact for Highly 

Ductile Members". This was a reporting issue only and the reporting was conservative. 

* 81180 An incident was resolved in which frame design was not being performed for load combinations of 

type "Range Add". This affected any user-defined "Range Add" load combinations as well as any 

auto-generated load combinations containing a load pattern of type "Settlement". The design results 

for these "Range Add" load combinations were zero. Load combinations of other types ("Linear 

Add", "Envelope", "Absolute Add", and "SRSS") were not affected. Auto-generated load 

combinations that did not contain any loads defined as being of design type "Settlement" were not 

affected. Versions 10.1.0 to v17.3.0 were affected. 

 81232 An incident has been resolved for steel frame design using the Australian AS 4100 code where the 

value of Lambda_wy for the major-axis bending mode was being used instead of the value of 

Lambda_wy for the axial mode while calculating the value of Mrx, the moment capacity in the 

presence of axial force for doubly-symmetric I- and box-sections and when Kf < 1.0 (slender in 

axial mode) (AS 8.3.2(b)). The design now uses the value of Lambda_wy for the axial mode. The 

previous result was slightly over-conservative. 

 81448 An incident has been resolved for the Italian NTC 2008 steel frame design code in which the 

following issues have been addressed:  1.) Some of the interaction equations were referring to 

Eurocode. The references to the equations are now made to NTC and Eurocode as appropriate.  2.) 

The choice of interaction methods “Method A”, “Method B”, or “Method Both” has been 

introduced for stability check of Class 1, 2, and 3 sections under flexure and axial compression 

(NTC Eq. C4.2.32, Eq. C4.2.37, Eq. C4.2.38).  3.) The equation for Mb,Rd has been updated by 

updating the expression for chi. The new expression follows NTC Eq. 4.2.5.1. Previously chi was 

based on EC3 6.3.2.2(1) which is really a simpler version of NTC Eq. 4.2.5.1.  4.) The expression of 

psi = 1.75 - 1.05 * (Mb/Ma) + 0.3 * (Mb/Ma)^2 was corrected (NTC Eq. C4.2.31). Previously it 

was psi = 1.88 - 1.40 * (Mb/Ma) + 0.52 * (Mb/Ma)^2.  5.) The beam/column capacity ratio is 

determined with appropriate gamma_RD factor: 1.3 for DCH and 1.1 for DCL per code (EC8 

4.4.2.3). Previously only one factor 1.3 was used.  6.) The buckling curve for the case of lateral 



SAP2000 v18.0.0 2015-10-28 Page 7 

* Incident Description 

torsional buckling of rolled I-shapes is now taken as "b" and "c" instead for "a" and "b" for h/b <= 2 

and otherwise, respectively. 

 81687 An incident was resolved in steel frame design per Eurocode EC 3-2005 with Eurocode 8:2004 

where the design checked the section compactness for DCH-CBF and DCM-CBF per section EC8 

6.5.3(2) and Table 6.3 correctly but unlike other frame types, this was reported through warning 

rather than error messages. Since this issue gave a warning instead of an error, the member was not 

colored Red, and the error message was not displayed in the summary window. Rather the warning 

was displayed in the details and in the database tables only. The design now issues an error message 

instead of a warning message. In addition, an omission in the manual has been fixed. This is in 

manual sections 9.4.2.1 and 9.4.2.2 regarding the required section class for beams and columns with 

behavior factor in DCM-MRF. 

 83457 An incident was resolved for the Chinese Concrete frame design code for column design where the 

additional eccentricity moments were being added only on the positive side. Also the seismic 

moment modifiers, if overwritten, will now be applied even if the column compression ratio is 

below 0.15. 

 
Results Display and Output 
Incidents Resolved 

* Incident Description 

* 38919 An incident was resolved where the option "Provide Output" in the definition of a staged 

construction load case had no effect. Results were provided for every stage regardless of the setting. 

Now setting this option to "No" will cause the stage to produce no output except for the last stage or 

for stages with target-force loading, for which output will always be provided. The default value for 

this setting when defining a load case has been changed from "No" to "Yes". Models from previous 

versions, when opened in the new version, will have this option set to "Yes" for all stages in any 

load case where all stages were previously set to "No". Otherwise the settings will not be changed, 

but the number of output steps produced may differ between the new version and the old version. 

 82639 An incident was resolved where in some instances the data shown in a report may appear in the 

wrong column. This was a report creation error only and did not affect the results as displayed in the 

tables or on the model. 

Database Tables 
Incidents Resolved 

* Incident Description 

 82486 An incident was resolved in which the database table filter criteria applied by the user was not being 

converted back to the current units when opening the form to modify or review the filter data. This 

did not affect any results. 

 82775 An incident was resolved where the interactive database could experience an abnormal termination 

when sending a table to Excel, deleting all records in Excel, and then attempting to retrieve the table 

data from Excel back into the interactive database. 

* 83178 An incident was resolved where tables exported to Excel using the command File > Export > 

SAP2000 Excel Spreadsheet could, under certain regional settings, produce incorrect values in the 

Excel file. Values were previously being exported as text in full precision, and the decimal separator 

could be lost. Now values are exported as numerical double-precision values to avoid this problem. 

This error only affected versions 17.2.0 and 17.3.0. When this occurred the error was usually 

obvious because the values could be incorrect by orders of magnitude. This error only affected the 

File > Export command. It did not affect Excel tables produced using the Display > Show Tables > 

Export Current/All Tables command nor the Excel tables accessed from the command Edit > 

Interactive Database Editor > Send Table to Excel. 
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Data Files 
Incidents Resolved 

* Incident Description 

 81238 An incident was resolved where the XML schema was not correctly exported for database tables 

that included fields starting with a digit instead of a letter. 

 82924 An incident was resolved in which import errors were generated when importing certain model text 

files containing data for ACI 318 concrete frame design preferences. 

 84264 An incident was resolved in which frame section properties imported from the Indian.pro section 

property library did not have the correct plastic modulus value for I and channel sections. The 

section property library has been updated to correct this and has modified the properties of a few 

other I and channel sections to be consistent with the currently available sections. 

Application Programming Interface 
Incidents Resolved 

* Incident Description 

 82939 An incident was resolved in which the API function SapObject.SapModel.Results.BaseReact would 

always return a value of 1, indicating an error. 

 84182 An incident was resolved wherein API functions SapModel.PointObj.SetPatternByXYZ and 

SapModel.PointObj.SetPatternByPressure would always set zero values. 

 84753 An incident was resolved for the Application Programming interface (API) where calling the 

function SapObject.SetAsActiveObject() on an instance of SapObject that had previously been set 

as the active instance caused subsequent calls to SetAsActiveObject() on all other SapObject 

instances to fail. Consequently, no other SapObject instance could be set as the active instance until 

the active SapObject instance was destroyed by closing the program or calling the function 

SapObject.ApplicationExit(). No results were affected. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 81291 An incident was resolved in which duplicate GUIDs (globally unique identifiers) could be exported 

from a single model. While this has no effect on analysis or design results, it could cause a conflict 

when importing the file into an application that uses GUIDs. Now when duplicate GUIDs are 

encountered during export to a file format that supports them, objects (frames, shells, etc.) with 

duplicate GUIDs are assigned new GUIDs before export, and load assignments with duplicate 

GUIDs are not exported. In the latter case, only the first instance of load assignments having the 

same GUID is exported, and a warning message is provided. 

 83632 An incident was resolved that addressed two issues affecting the export and import of IFC files:  1.) 

Very small numbers, less than 1.0e-7, were incorrectly written out as zeroes in IFC files exported 

from SAP2000. When this happened, the geometry of the model was still correctly exported. This 

error was rarely significant, except for the case of mass or weight density in kN-mm units. Now the 

actual values are always written, no matter how small, except for distances and dimensions which 

are set to zero if smaller than 1.0e-7 meter.  2.) GUIDs (globally unique identifiers) were incorrectly 

read when an IFC file was imported. As a result the imported GUIDs in the SAP2000 model 

differed slightly from the GUIDs of the original IFC objects. This error had no impact on the 

SAP2000 model analytical validity or results. 
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Documentation 
Incidents Resolved 

* Incident Description 

 83626 An incident was resolved in which the steel frame design manual for the Australian AS 4100-1998 

code did not document the calculation of the overall slenderness, lambda_s for sections that were 

not hollow and circular. One paragraph is added in the documentation. This was a documentation 

issue only. No design results were affected. 

 


